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Jumping in and solving your first ticket
We go through the fundamentals of ticket/case management in Zendesk. You'll learn how your
customers can submit tickets through email and where those tickets appear in your Zendesk. You'll
also learn how to respond to and solve tickets; as well as how to view the history of the ticket, which
will show you every action both you and the customer have taken on the case.

In this first lesson, you'll create and resolve your first customer service incident using Zendesk.
The way we do this is by submitting a request by email and then responding to that request within
Zendesk. Putting yourself in your customers' shoes, you'll see how Zendesk captures and keeps track
of support incidents; as well as use some of the tools Zendesk offers you and your support team to
work more quickly and efficiently while addressing those incidents.

Submitting your first ticket
The central piece of Zendesk is the ticket. Whenever a support request is received in Zendesk, a
ticket is created. The ticket then becomes a record of each one-to-one customer conversation you
have. Tickets can be created through multiple channels: email, your website, social media, online
chat, phone, and more. Wherever these conversations are started, however, they all become tickets.

Once the support ticket has been submitted, your goal is to resolve it as quickly and efficiently
as possible, whether it's a simple question about how your product works, or a major customer
problem. In each case, the support conversation goes through a series of stages: the ticket might
require your attention or it might be waiting on some information from the customer; eventually, it is
resolved.

In this lesson, we are going to submit a support request using email.

Zendesk comes set up to work with email. When you signed up for your Zendesk account, you were
given a Zendesk support email address: support@youraccount.zendesk.com where "youraccount"is
the site name you signed up with. You can see your account name in the URL displayed in the
address bar.

Note:  You can change this email address, which we'll get to in the next lesson.

We're going to send an email to this address.

Tip! If you are an admin, it's important that you send any test emails from a different email account
than the one you use with your administrator account. Since your Zendesk recognizes your email
as the owner of the account it treats you differently than it does one of your customers. In general,
it's good to have a separate email address that you use to test your Zendesk. This gives you the
opportunity to experience Zendesk the way your customers will.
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Open up your email and send an email as if from a customer to your zendesk support address
(i.e. support@youraccount.zendesk.com). Our account is called MondoCam - an international
camera company we use for demo purposes. So in our case, we are sending the email to
support@mondocam.zendesk.com.

You can write whatever you want, but it can be helpful to write something you might actually see
from a customer.

That's it! Your first support ticket submitted.
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Seeing and replying to support tickets
Back in our Zendesk account, let's see where that email ended up. Once a customer sends you a
ticket, it will be automatically converted to a ticket and show up in your Views. To see those, hover
over the View tab in the top navigation.

Views are like custom inboxes for your support tickets. We'll discuss them more in Lesson 5. The
default view is called My unsolved tickets, which shows you any ticket that you haven't deemed
solved yet. The ticket you just sent in will show up here. If you haven't already, click on My
unsolved tickets.

There it is! Nice. Click the title of the ticket to open it. The ticket is where you respond to the
customer; but the ticket will also keep a log of all the subsequent communication between your team
and the customer. Let's go ahead and respond to this ticket now.

We want to ask the customer for more information. To do that, add a comment below the initial one
asking for more information. Simply type your response in the text box.

Next we'll change the drop-down fields on the ticket labeled Status, Type and Priority. Zendesk
can add and keep track of a support conversation's details by setting these drop-down fields, or as
they are called in Zendesk, ticket fields. You can modify these ticket fields as well as add your own.
We go over that in Lesson 5.

The status field says "open". A Zendesk ticket can have five statuses, each of which marks a
different stage along the path from a customer submitting a request to your agents solving it.

1. New - a ticket that has just come in and hasn't been opened yet.
2. Open - a ticket that has been opened and requires attention. Open tickets are the ones that are

currently on your plate.
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3. Pending - a ticket that is waiting on another party, usually the customer. Use this for when
you are waiting on a customer reply.

4. Solved - means the ticket has been deemed resolved. Can still be re-opened however.
5. Closed - once a ticket has been solved for a number of days, it is officially (and

automatically) closed. Closed tickets are archived and cannot be reopened.

We are asking the customer to send us more information, so change the status of the ticket to
pending. By changing the status, we help ourselves organize our tickets into ones that require
attention and those that we can't work on at the moment.

Next, the Type drop-down field. Like status, there a number of ticket types. The type describes what
kind of issue you are dealing with. There are four ticket types; and depending on which you choose,
you get a different set of features.

1. Question - the most basic type; for when a customer has a question about your business or
service.

2. Problem - for when a customer has a problem with your business or service
3. Incident - are specific instances of problems. For instance: if the problem is that our billing

system is down, each ticket that comes in after we identify the problem is an incident of the
problem. This lets us group our tickets together around a common issue.

4. Task - are for tickets which turn into a to-do item for your agents. They can have a due date.

Because the customer is asking a question about our product, we will change the Type field to
Question. We might change that later as we gather more information. Lastly, because we aren't sure
exactly what is going on yet, let's set Priority to Normal. You could also choose Low, High, and
Urgent. Priority is another ticket categorization tool. When we look at ticket organization in Lesson
4, we will see how you can use priority to focus on your highest priority tickets.

OK, your ticket should look something like this:
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We are now ready to reply to the customer. To do so, click the Submit button under your comment.
This will update the ticket with all the changes we just made and send out our reply to the customer.

Zendesk returns you to your unsolved tickets view with a message that you've updated your ticket.

What your customer sees
When you click Submit, Zendesk sends out your comment to the customer. Let's see what this looks
like. We'll check the email account we used to send in the test support request.

You will see two replies:

1. Your Request has been Received
2. An update with the comment you just added.

These replies were automatically sent out by your Zendesk through something called a trigger.
Triggers are automatic actions that occur when tickets are created or updated. They act like this: "if
A happens then do B". So for instance:

1. When a customer submits a ticket
2. Zendesk automatically replies and acknowledges that the request has been received.
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That's where that first email came from.

But a trigger also sent out our second email:

1. When you make a comment on a ticket
2. Zendesk automatically sends that comment back to the customer.

The subject line of the second email should read something like "[MondoCam] Re: Problems using
the XR50-HyperShot". Click into that email.

It has both your comment and the original request for support. There is also a link back to the ticket.
All of this is controlled by the trigger that sent it out. Triggers are a powerful tool in Zendesk and
we'll go through them at length in Lesson 5.

How your customer replies
How does your customer respond? As the email says, "You can add a comment by replying to this
email". Let's try it.
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Hit reply and type out a response from the customer perspective. In our example we asked for the
customer to attach an image. Go ahead and try this as well, attach an image to your email and click
Send.

Go back to your Zendesk and return to the My unsolved tickets view (click the View tab to get
there). There's your ticket, with the customer reply showing. Notice too that ticket status has
changed from pending to open.

Since the customer replied, you are no longer waiting on them. This reopens the ticket and puts it
back on your plate.

Solving a ticket
Let's resolve this issue now. Click in to the ticket. There is the customer response along with the
image we attached—cool! You can click quick view to see your image right from within the ticket.

Now we have enough information to solve this ticket. We will respond with the answer to their
question; and we can change the status to solved in the drop-down menu. Your ticket should look
something like this:



14 | Getting Started with Zendesk® Classic | Jumping in and solving your first ticket

Notice that we can also attach files to tickets. Just click the Attach file link in the lower right of the
comment box. Once we are satisfied that we have successfully trouble-shot the customer's issue and
answered their question, we can hit submit.

Easy as that! We just solved our first ticket. Your Zendesk even tracks your weekly progress by
telling you how many tickets you've solved (see picture below).
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Reviewing a ticket's history
We just went through a pretty typical support interaction in Zendesk. A customer contacted us with
a question; we troubleshot the issue; and ultimately answered their question. But Zendesk not only
helps us to resolve the issues; it keeps a history of all the activity. Let's review the ticket history.

To return to our ticket, click the Recent tab in the top menu bar. This gives you quick access to any
tickets you handled recently.

Now in the ticket, click the All events and notifications link. It is in the top right of the Comments
section.

This shows us every change that occurred on our ticket. You can see the changes we made manually
like changing the Type to Question; as well as the automatic actions taken by Zendesk—such as
the trigger that sent out the notification emails when we added new comments, as well as when the
customer replied and the ticket went from Pending to Open.
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Notice too that a notification was sent out when we solved the ticket.

Summary
In this lesson, we jumped right into the support process with Zendesk. We saw how Zendesk
receives support requests through email and turns them into tickets. And then we went through the
basic steps you take to resolve that request within Zendesk.

Now that we have the basics down we can start to take advantage of some of Zendesk's other
features and tools. In addition to email, for instance, Zendesk can receive support requests from
multiple channels, including web site forms, live online chat, and Twitter.

We'll also be diving into triggers more to see how they can automate and accelerate a lot of your
support tasks; and discuss how you can organize your customers and agents into groups.

Next Lesson: Customizing the agent home page
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Customizing the agent home page
We will orient you to your Zendesk web portal home page and navigation. You'll also learn how to
customize this page for your agents and you, including changing the color scheme and adding your
logo, as well as customizing the text on this page. By the end of the lesson, you'll have a home page
tailored to your support team.

In this lesson, we're going to go over and customize what you see when you first log in to Zendesk.
If you just created your account, you will initially see the Getting Started Screen (see picture below).
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However, on your subsequent logins you will be directed to your web portal home page. (You can
also always get there by clicking the Home tab in the menu bar.) For new accounts, that screen looks
like this:
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We'll show you ways to change the information on this page as well as customize the look of it.
Your agents and you will be spending a lot of time working in this web portal, so it makes sense to
get to know the interface, as well as how to get your content in there, and integrate the look of it with
your company's look.

There are five main areas to your support home page:

1. Header and menu bar
2. Introductory text
3. Highlighted forum articles
4. The forum directory
5. The sidebar
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Header and menu bar

Your account name is in the upper left of the header along with a Zendesk logo. Links to your
personal profile and to Zendesk's help are in the upper right. The menu bar of your web portal goes
across the bottom of the header.

Adding your logo and colors
Zendesk offers some simple web tools to change the colors and add your own logo. Anyone can use
them, you don't need to be a programmer or designer.

Note:  There are some advanced customization options as well, which we will look at in the next
lesson.

While the Zendesk logo is nice, let's swap it out with our own logo.

All the basic personalization tools are in Settings > Account > Branding. Go there and scroll to the
bottom until you see Header logo.

Adding a logo is as simple as uploading it here, but it's important to note that Zendesk will resize
the logo to fit within a space 254px wide by 50px tall, so it's best to make sure you have a version of
your logo optimized for that size.

When you have a version of your logo that looks good at that size, click the Choose file button and
browse to it from your computer. It is fine if the image is larger than 254px by 50px—but Zendesk
will scale it to fit within that space.

When you choose a new logo, you can also indicate a URL to which you want the logo to link. It
makes sense to add your own website.

Click Save changes on the bottom of the page and you have a new logo.



Getting Started with Zendesk® Classic | Customizing the agent home page | 21

Changing the colors
Now, unless you happen to have the exact same color scheme as Zendesk, your logo probably looks
a little funny up there. Let's change the colors to fit our brand and work with the logo better.

You should still be in the Personalize your Zendesk page. Scroll to the section labeled Help desk
colors. Click on the green bar next to page header. Up pops a color picker tool.

We can either choose the color using the color picker (the round dot on the color block) or by
entering in the hex number for the color.

Tip! Hex numbers are a computer standard code for describing colors.

We are going to enter the hex number for our brand color—which is a deep blue—#002262. You
can use either the color picker or also enter a hex number. Do the same for the page background with
the alternate color. The page background is the frame around the main content of the page (pictured
below).

Click Save change at the bottom and your new colors are now visible.

If at any point you want to start over, you can return to the default green and dark grey colors by
clicking the Revert to default colors link in the help desk colors link.
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The menu bar
Now that we have changed our colors and logo, let's take a look at the menu bar. This is how you
will navigate your support site.

1. Home - brings you back to the support home page
2. Forums - your knowledge base and community support
3. Manage - a menu where you manage the pieces of your help desk including users, work

flows, and pre-built responses.
4. Settings - a menu with administrative and ownership control, including branding tools and

tools that integrate your Zendesk with other tools.

Note:  You'll only see the Account menu if you're an administrator. Individual support
agents will not have access to these settings.

5. Twitter icon - Zendesk allows you to monitor and respond to support requests that come
through Twitter. This tab gives you direct access to that feature.

6. Views - are customizable collection buckets for all your support requests.
7. + New- takes you directly to a new support ticket.
8. Search Bar - searches your entire support history, including knowledge base and tickets.

The Manage and Account tabs have a number of related sub menus.

Hiding the introductory text
Let's look at the other sections of your web portal home page and make a few changes to get you
started.

The introductory text is the section right below the menu bar. It is completely editable and a
good place to put a welcome message or other information about your support—hours, contact
information, etc. The introductory text comes more into play when we start to configure the web
portal for our customers' use, so let's hide it for now.

To hide it, go to Settings > Channels and then click the green Edit link next to Web portal. This
page has a number of settings for your web portal content - what is shown and how it is displayed.
To hide the introductory text, uncheck the Show box on the first item and click the Save button at
the bottom of the page.

The remaining settings all address your Zendesk forums. You can use forums to build out a
knowledge base and FAQ section, as well as to offer community support, creating a space for your
customers to ask public questions and engage with other customers.
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As you see, you can choose to show your forums on your home page. Let's return there to see what
they look like. Click on the Home tab in the menu bar.
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Adding a knowledge base to your web portal home page
The forums occupy the bulk of your home page. Forums are collections of articles and/or
community questions and feedback. Each entry in a forum is called a topic. One great way to
utilize that is to add a knowledge base and start building up some documentation on your product
or service. This can be helpful for your support agents as they are troubleshooting a customer's
questions. It centralizes your support knowledge in one place and integrates it with your ticketing
system.

To start building a knowledge base we are going to explore the forums, add some new content
relevant to our business, and display that on our web portal home page.

When you first sign up for your Zendesk account, you are set up with a few example forums—
Announcements, Community Help, Tips & Tricks, Feature Requests, and Agents Only. If these
sample forums work for you, you can definitely start adding content to them.

For our knowledge base example, let's customize the forums so that they are organized around our
product line. We want to group articles around each product we manufacture to make it very easy to
browse. To do that we are going to create separate forums for each product line and then group them
into a forum category called Knowledge Base. Lastly, we'll configure how it displays on the home
page.

Creating new forums
To create a new forum around a product line, we will go to the Forums page on our Zendesk. Click
the Forums tab in the menu bar. It looks very similar to what we had on our home page. But while
the forums can be displayed on the home page, all forum organization and configuration happens
here. Notice the green actions link on the right side of the page, which were not available on the
home page.

Add a new forum by clicking the Actions link and choosing Add forum.

Add a title of a product line. We'll call our "Digital Compact Cameras", one of MondoCam's product
lines. Add a description of the product line in the description field—this will be displayed along with
the forum and can provide some general information about the product. Leave everything else as is.
These options become useful later when building out an area for customer community support. For
now we are focusing on knowledge base articles and the defaults work well for that. For more on
community support and forum options, check out the community support video tutorial.

https://support.zendesk.com/entries/176227-community-support-and-knowledge-base-sharing
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Click the Add forum button at the end of the forum. This takes us into our new forum. The title we
just added is across the top, along with some breadcrumb style navigation (you can click Forums
to go back up one level); a search bar allows us to search within that forum (not that interesting yet
as we have no content); when we add forum topics, they will be listed in the main column; and the
description we wrote is in the right column.
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Let's add a knowledge base article about this particular product line ("digital compact cameras" in
our MondoCam example). Click the Add article button on the right side.

On the next page, you create your knowledge base article by adding a title and the article body. For
our example, we are going to add a question a customer might ask about our product line. This will
help our agents troubleshoot customer questions.

You can either write something from scratch, or if you have an existing knowledge base, simply
copy and paste an article into the text box (you can paste in text as well as images). Notice the drop-
down titled Which forum does this topic belong to? It has our new forum selected, but you could
change it to another forum.

Lastly, we can set a few options for how this topic is displayed. We don't want people to leave
comments on our knowledge base articles—we'd rather have them submit a support ticket if they
have questions—so let's check the disable comments box. Leave the other items unchecked for now.
Your form should look something like this:
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Looks good. Click Update in the bottom right of the form. This brings us to the forum topic as
people will see it when they browse to it. If you need to ever make a change to your documentation
—when a product is updated for instance—you can edit it at any point by clicking the green Edit
link in the upper right of the article.

OK, remember that we were adding a knowledge base article to display on our web portal home
page. Let's go back there and see what it looks like. Click the Home tab in the menu bar.

Looks OK—there's our forum along with the sample forums Zendesk starts you off with; and the
article we just added is listed.



28 | Getting Started with Zendesk® Classic | Customizing the agent home page

But it could look even more organized. And some of those sample forums don't apply to our
business. To clean up how this looks, and make it much easier to browse for our agents, we can
create a forum category.

In addition to grouping related topics together in forums, you can group related forums into
categories. Let's create a category called Knowledge Base and move our product forum into it.

Create a forum category
Creating a forum category is very similar to creating a forum itself. First, as we did before, we need
to go the Forums tab in the menu bar. On the forum management page, click the Add category
button in the upper right of the main column. On the new category page add a title and a description.
The title will be displayed on the home page as a section heading (see picture below)



Getting Started with Zendesk® Classic | Customizing the agent home page | 29

We'll title ours "Knowledge Base" and add a simple description: "Official Articles, Manuals, and
Tips about all of MondoCam's products". When you click Update, you'll see your category on your
forum management page. Let's see how it looks on the home page. Click the Home tab.

Next, we want to move our product forum into the Knowledge Base category.

To move the forum category you created earlier, click the title of the forum; and then click the green
Edit link on the forum page. You'll now notice a drop-down titled "Which category does this forum
belong to?" open that up and choose "Knowledge Base" (or whatever you named the category you
created).
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Click the Update forum button.

Now when you go to the home page your category shows up with your forum within it.

How are we doing? Our web portal home page is definitely taking shape. It sports our logo and
colors, and we are starting to build up a knowledge base for our agents to access. From here, you can
continue to organize and add articles to your knowledge base.

Pinned forum topics (and how to unpin them)
There's one last item on the home page we haven't looked at yet. The message titled "For Your Eyes
Only".

It reads: This topic was posted to the restricted Agents Only forum in your help desk and pinned to
the home page. The topic is visible to help desk agents only, not your customers.

This points to an aspect of the web portal home page and of forums that we haven't considered yet:
what can your customers see? We are going to look at that in the next section.

For now, let's focus on the other piece introduced by this post: the idea of pinning topics to the home
page. It turns out that this "For Your Eyes Only" post is a normal forum topic. You may remember
from earlier in the lesson a set of options for how a forum topic is to be displayed (see picture
below).



Getting Started with Zendesk® Classic | Customizing the agent home page | 31

One of those options was to pin a topic to the home page. When you enable this option, it shows up
on your home page just like this "For Your Eyes Only" post. This gives you the ability to showcase
particular content that could be useful for your support agents.

And when that content is no longer useful—perhaps you want to highlight a product update, but only
for a week—you can unpin it. Now that we have read the "For Your Eyes Only" post, it isn't really
something we need to see every time we log in.

To unpin it, all we have to do is click the Unpin link under the title.

It disappears, but note that it hasn't been deleted. You can still see it listed in the "Agents Only"
forum in the forum directory on the home page.

Tip! To re-pin something, go into the topic and click the green Edit link the upper right of the main
column. Select the checkbox at the bottom titled Pin to home page and update the post.

Summary
In this lesson, we customized the agent home page to look more in line with your company's brand.
And we started building a knowledge base that your agents can use when troubleshooting customer
questions. We looked at how the Zendesk forums are organized, with topics, forums, and categories;
and saw how to move items between forums and categories. Lastly, we saw that we could highlight
particular forum topics by pinning them to our web portal home page.
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In the next lesson, we'll return to setting up Zendesk for your customers point of view. We'll set up
your web portal for their use so you can communicate important news and announcements to them;
so they can help themselves to your public knowledge base; and so they submit tickets and keep
track of their support history. We'll also make the support experience more seamless for them by
removing the word Zendesk from your support email and your web portal URL.

Next Lesson: Customizing the Customer Experience
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Customizing the customer experience
In this lesson, we will look at your help desk from your customer's perspective and learn how to
customize their experience. We will edit the content on the support home page that your customers
see. You'll customize your support web portal URL and email address so that it uses your company's
domain instead of Zendesk's; and we'll go through the steps to set up your Zendesk to work with
your own company email address.

So far, we've been working on the web portal home page you see when you log in to Zendesk. What
do your customers or colleagues see when they visit the site?

You've probably seen it already if you have logged out and then come back to your Zendesk. It looks
similar to the home page you see when you log in, but optimized for your customer. The navigation
is different and anything that is marked for logged in agents and admins is hidden.

The important concept here is that your web portal home page serves both your support team and
your customers. Keep that in mind as you are pinning topics to your home page, writing your
introductory text and building out your forums. It is a best practice to run through your own support
experience from the customer perspective to ensure it offers the kind of support you want to offer.

In this lesson, we are going to review our web portal home page as our customers see it and
adjust the content to provide the optimal experience. We will also customize the URL of our
Zendesk support site so it can match your business URL. It is important that the support experience
you provide your customers feels integrated with the rest of your customer experience. The
URL is part of that. Additionally, we will also remove the ".zendesk" from the support email
address for both incoming and outgoing messages so that your customers can send email directly
to support@mondocam.com rather than requiring support@mondocam.zendesk.com.

Assuming a customer perspective
In order to see what your customers see on the home page, you can simply log out—but this gets
tedious over time. You don't want to keep logging out and logging back in just to see what your
customer sees while you're working on your support page. A better, quicker way to work on your
web portal is to assume the identity of a customer while still logged in to your Zendesk.

In Zendesk, you can assume the identity of any user of your support system. This means
experiencing your help desk from their perspective. This can be helpful to guarantee that the system
looks and behaves as you want it to for each person.
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Step 1
Click on the Manage tab in the top navigation and choose People. If you just created your account
you don't have many users yet, but everyone that has interacted with your help desk so far is in here.
(We'll go over the People section in more detail in Lesson 5).

If you are the person who created the account, you should see yourself in the list as Owner. There is
also the test user with the email address from which we sent in a ticket in Lesson 1. (You might also
have Kelly H in there, who is a Zendesk employee who has sent you a ticket to help you get started.)

Step 2
To assume a user, you can either hover over their name in the user list and click the Assume link
that appears; or you can click the Assume an anonymous user link the right column. An
anonymous user is one who comes to your web portal and does not log in.

Tip! Once a customer sends in a support ticket, they have the option to create a password for
themselves and log in. This will give them access to their support history—every ticket they sent in
—as well as allow them to participate in your forums.

Let's review the website from an anonymous user. Click the link in the right column.

This drops you back on to your home page—it looks similar to what we were looking at earlier in
the lesson, but notice the small differences:

1. The menu bar is different.
2. You do not see the "Agents Only" forum



Getting Started with Zendesk® Classic | Customizing the customer experience | 35

The menu bar has some new items. Your customers can visit your forums, but instead of having
the Manage and Settings tab, they have tabs for submitting new support tickets and for checking
support tickets they have submitted in the past.

As for the rest of the page, it has the forum directory we were working on in the last lesson,
including our Knowledge Base with our new product line forum. It does not, however, have the
"Agents Only" forum. As we read in the "For Your Eyes" only topic in the last lesson, you can
create forums and restrict access to them, allowing only your support agents to see the topics within
them.

The customer web portal home page does show the other sample forums that Zendesk starts us off
with. While Zendesk sets you up with a number of items and tools to help you get started, it's best
practice to remove items you aren't using once you get the hang of things. This will make your
Zendesk much easier to use for your agents; they will not have to wade through items irrelevant to
them.

Now that we've started building out and organizing our knowledge base, let's clear out content we
aren't using. Look through the forums that Zendesk starts you with and decide if you want to use any
of them. It's not a big deal if you remove them and decide to add them back in later. You saw how
simple it was to add a new forum earlier. You can always add forums later.

For our example, let's keep "Announcements". We sometimes have announcements about new
products or news updates that we want to share.

To remove the unused forums, we need to switch back to our administrator profile. To do so, click
the Revert identity link in the upper right. This will bring you back to the People page.
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Configuring the customer web portal home page

Removing unused forums
Back in the admin view, let's remove the forums we aren't going to use. To do so, click on
the Forums tab. Once there, click on one of the forums you are going to remove—"Community
Help" for instance. Now click the green Edit link in the upper right of the main column. At the
bottom of the page, there is a Delete link.

Click that and confirm your choice when the alert pops up.

Done! Easy. Now repeat those steps to remove other forums you don't plan on using. For this
example, we are going to keep the "Announcements" forum and the "Agents Only" forum. We want
to keep some documentation private to our internal staff. We don't like the name "Agents Only"
however. Let's call it "Internal Documentation". To make that change click the title of the forum
and click the Edit link as you did in the previous steps. Rather than delete the forum, however, just
change the title.

Before you click the Update button, notice the Agents only radio button at the bottom of the form
that sets the permissions for who can view topics in this forum.

That's how you restrict your forums and make them invisible to your customers. Leave that as is and
click the Update button.

Adding the introductory text back in
Let's make one more change to the customer web portal home page—add back the introductory text
we removed in the previous lesson. Now that we've seen what the customer sees when they visit our
web portal, it makes sense to have some text that welcomes and orients them to the site.

To show that text, go to Settings > Channels and then click the Edit link next to the Web
portal section. Click the Show box in the Introductory text on portal home page section (the first
item). Click the Save button at the bottom of the page; and then check to make sure it is there by
clicking the Home tab in the menu bar.
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There it is! Feel free to edit this however you like, keeping in mind that the introductory text is
visible to your customers. To make edits, click the green Edit link in the upper right. You can of
course keep the default text that Zendesk starts you off with, a generic welcome message.

Once you have the text as you want it, check to see how everything looks by following the steps
earlier in the lesson and assuming an anonymous user.

Looking good, but there are two pieces that might confuse our customers—the Zendesk support
email address in the introductory text and the Zendesk in the URL. As we are making the web portal
fit more and more with our company, let's also extend that to email address our customers use to
send in support requests, and the URL they visit.

Using your organization's email address and URL
Using your own email domain with your Zendesk is easy to do and well worth it. Customers respond
better when they see that their question or problem is being handled directly by the company. While
you could use the default support address that Zendesk provides you upon sign up, it can sometimes
be confusing to a customer when they see another company in the address. "Am I writing to the right
company?" they may wonder.

So let's set it up so that your customers write to and receive emails from
simply: support@yourcompany.com. (In our case, that will be support@mondocameras.com.)

Part of this happens on your end with your email server (whether it's Google Apps, an MS Exchange
server, or some other system your organization uses for managing your email account). Because of
that, we will give general instructions easy to follow for whoever administrates the organization's
email.
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Receiving support emails at your organization's email address
As we showed earlier, it's quite simple to get mail into your Zendesk. Just send an email to the
Zendesk support email you received upon signing up. Using your own support email address is
almost as easy.

If you don't have an email address that you use for support already, the first step is to create one.
This is something usually handled by whoever administers the email for your organization. It can
be whatever you want: support@yourcompany.com; help@yourcompany.com; info@... you get the
idea.

Once you have created the address, or if you already have an email address you use for support
(say: support@yourcompany.com), simply set it up to forward any mail it receives to your default
Zendesk address (support@youraccount.zendesk.com). That's it! The customer will email your
address which will send it on to your Zendesk address behind the scenes. They've never see the
Zendesk name in the email.

Tip! If you use gmail, or another email platform that requires you to verify the address to which
you are forwarding, you may need to check your Zendesk suspended tickets view (under Views >
Suspended tickets) for the verification email.

Important! If you currently have a support email that you receive support emails to, do not forward
that address to your Zendesk until you are ready to start using Zendesk for your real support. Those
emails will start coming into your Zendesk as soon as you set up the forward. Better to stick with the
default Zendesk email address for testing and set up.

Email forwarding is generally a simple process based on a rule engine in your mail server. You say:
when a mail comes into address a, send it to b.

Sending support emails from your organization's email address
Now that you can receive emails using your own email address, let's make sure that your customers
also receive all your support responses from that same address (as opposed to receiving email
from the support@youraccount.zendesk.com address). This is not entirely necessary—the whole
communication back and forth will continue to work even if you don't set this up—but it might be
confusing for customers who email one address and then receive a response from a separate address.
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To set this up, go to Settings > Channels > Email. Find the section labeled Default reply email
address. Unless you've already changed it, you should see that default Zendesk support email
address you got when you signed up.

Replace that with your own email address (we recommend using the same one you set up to forward
mails into your Zendesk, e.g support@mondocam.com in our example). Click Save changes at the
bottom of the page.

Now, that will work in most cases, but to ensure your mail from Zendesk is delivered correctly, you
should also set up what's called an SPF record with your domain registrar (e.g Godaddy, Network
Solutions, Hover, etc.). Essentially what's happening here is that Zendesk is sending out mail which
it is then saying is from your email address. This is fine, and the SPF record basically tells the
computer that receive emails delivered this way that it's all right for Zendesk to send mail under your
email address. If you don't do this, there is a chance your emails may be flagged as spam.

We explain how to set up this SPF record in the Zendesk User's Guide: Using an external domain.
It is a bit technical—if you have someone who manages your web site, they would be the ones
to talk to about this—but the place you registered your domain name should have some good
documentation on how to do it as well.

Using your own domain name
OK! We've changed colors and logos, and set it up so that all email communication comes from your
own domain name. Lastly, we'll remove the ".zendesk" from your support site URL so you can use
your own domain name; so, for instance, instead of typing mondocam.zendesk.com your support site
would be at support.mondocam.com.

This is also a bit technical and will require more work at your domain registrar. Essentially, what we
need to do is go to the place where your domain name is registered, create a special address, and say
that whenever a person goes to that address, show them your Zendesk.

You will be creating a subdomain of your website, meaning something
like: support.yourwebsite.com or help.yourwebsite.com, where "support" and "help" are the
subdomains in that example (though, your subdomain can be whatever you want).

Step 1
Create a CNAME record within your DNS settings. That's a lot of acronyms we know, but your
domain registrar or the person who manages your website should be able to set it up. We've written
up an example with Godaddy in our support forums. The important part is that you point your
subdomain (sometimes called a hostname or an alias) at your default Zendesk account address
(which is the address in the URL when you first create your account).

https://support.zendesk.com/entries/20519931-using-an-external-email-domain
http://www.google.com/url?q=https://support.zendesk.com/entries/13976-mapping-a-host-name-of-your-own-to-zendesk-using-cname&sa=D&sntz=1&usg=AFQjCNEMPPlTUMsJhAh1iidHnyRo_ESNHw
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Step 2
Once this is created, you can go back to your Zendesk and to the Account page under
the Settings tab. Click Branding on that page and enter the entire URL you created with
your CNAME record in the Host mapping field. In the example above, that would be
support.mondocameras.com

Click Save tab and now your new support site is on your domain name. Congratulations!

Tip! It is very important that you create the CNAME record first because if that is not in place when
you put your new URL in the Host mapping field, you will be unable to reach your support site
home page. If this does happen to you, you can always go to youraccount.zendesk.com/access/
normal which will bring you to your home page no matter what happens.

Summary
In this lesson we went over how to make your Zendesk a part of your organizations overall look,
feel, and identity by changing the logo and colors to match your branding; as well as using your
name and hiding the Zendesk one so your customers don't see the Zendesk name while interacting
with your support.

Next Lesson: Organizing your support tickets with views
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Organizing your support tickets with views
We go through the fundamentals of ticket/case management in Zendesk. You'll learn how your
customers can submit tickets through email and where those tickets appear in your Zendesk. You'll
also learn how to respond to and solve tickets; as well as how to view the history of the ticket, which
will show you every action both you and the customer have taken on the case.

Once support requests start coming into your system, you need to organize them into groups that
make working with them easier. If you had one support request a day, organization is not that
important; but once you start getting tens or hundreds a day, you need to be able to view them
in groupings which are meaningful to your business and your support team. Otherwise, you risk
becoming overwhelmed with a lot of tickets and unable to decide which ones require your attention.
Just think if you never filed anything away in your life and you just put everything in one big pile.
You'd lose control of what was in it pretty quick.

In this lesson, we're going to look at Zendesk views. Views are customizable inboxes for your
support requests or tickets. To see your current views, click on the Views menu in the upper right of
the menu bar.

Views organize your tickets into groupings which should help you stay on top of them. Perhaps
you want to know which tickets need your attention; or to be reminded of tickets which haven't
been addressed in a while; or see all the high priority tickets in your system. Views let you see your
tickets in these and many more ways.

While Zendesk provides you with some default views, it's important that you set up your own views
which will help your support team focus on the tickets they need to address when they need to
address them.

We'll be changing one of Zendesk's default views to highlight which of our unsolved tickets are open
(require our attention) and which are pending (waiting for more information from the customer).
You'll recall from lesson one that Open and Pending are different ticket statuses. This will help us
focus in on which support issues we should be working on at the moment.

We'll also deactivate some of the default views we aren't using at the moment.

What's open and what's pending?
Before we actually change any of the views, let's check our main view—My unsolved tickets. Click
the View tab in the upper right of the top menu.

If you haven't already, you should see a ticket in there from Kelly H. titled "Welcome to Zendesk,
You've Got a Ticket!". Kelly is a real-life Zendesk support agent. Click into the ticket and read what
it says.
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She submitted this by sending an email to your default Zendesk support address
(support@youraccount.zendesk.com). Because it will actually be helpful to what we are doing in this
lesson, we are going to follow her directions: reply to the ticket and set it to pending.

Recalling what we did in the first lesson:

1. Reply to Kelly as she suggests: How am I doing?
2. Change the status to pending
3. Update the ticket

Tip! If you want to check what happened when you hit submit, remember that you can always see
the ticket log by clicking the All events and notifications link.

Now we are back in our view. Depending on how much testing you've been doing on your own,
you might only see the one pending ticket. Let's add another one for testing purposes—since we
are setting up our view to show us which tickets are pending and which are open, it would be better
if we had an open ticket in there. It's a good practice to create test tickets as you work with your
Zendesk. Every time you add something new or want to change something, you can use your test
tickets to make sure it works as you expect. Better to test on yourself than on your customers.

To create a new ticket click the New button in the top right of the menu bar. This brings you to a
new ticket form. While many tickets come in to your Zendesk via email, you might use the New
Ticket button to create a ticket in response to a phone call, for example. The new ticket form looks
like the tickets we've been working with, except nothing has been filled in yet.

Let's say your boss has called you with an urgent request from a VIP customer. To keep track of that
request, you create a new support ticket. Fill it out with the customer's information and the request.
Because we have not communicated with this customer through Zendesk before, we need to add
them to the system first. Click the Add new user link under the Requester text field.

Note:  Zendesk requires an email for all customer tickets. This is why a customer account is
automatically created when they email a question in; but why you need to add their email manually
when filling out a new ticket. Put in the user's name and phone number if you have it.
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Click Create and then fill out the rest of the ticket with an urgent request. So even though you
are the one filling out the ticket, you can ascribe it to the user. They will receive any further
communication just like a normal ticket; and you will be able to reference this issue later when
looking at their user account.

Change the Type to Problem and the Priority to High. Your form should look something like this:

Note that the customer data you just added is on display in the right column.

Click the Submit button to create the ticket.
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List vs. table layout
Now we have at least two tickets in our unsolved tickets view: the one from Kelly and the one we
just created. They are currently displayed in List layout, which shows the subject of both tickets as
well as the most recent comment. There is also a small label indicating whether the ticket is open
—and thus requires attention—or whether it is pending—meaning that you are waiting on further
information.

List layout is good for seeing the most recent activity on tickets, but we want to focus more on
which of our unsolved tickets are pending and which are open. To do that, it is best to view the
tickets in Table layout. It's best practice to create a list that separates all the tickets that currently
require your attention from the tickets that don't. This will make your support agents and you much
more focused and effective, especially if you are dealing with a large volume of tickets.

To modify the layout, click the Table link in the upper right of the main column.

Nice! The table layout separates the tickets into two distinct areas, those that are open and those that
are pending. So now when we look at our unsolved tickets, we can quickly see which ones require
our attention.
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Note that by selecting the table layout, we're not establishing a permanent change in how we view
these tickets. Next time you go back to the Home tab and then come back to view your tickets, they
will be back in the List layout as it was when we started. So we'll edit our unsolved tickets view so
that it always shows our tickets in table layout, and grouping our open and pending tickets.

Editing a view
To change how a view looks (as well as which tickets it shows you), click the Edit link in the top
right bar (in the same place as the Table link you clicked earlier). Go to your Views > My unsolved
tickets if you aren't there already and click that green Edit link.

It looks similar to the Triggers page we looked at in Lesson 1. Basically, the top section defines
what kind of tickets you want to show up in the view (i.e. this could be tickets assigned to you,
high priority tickets, tickets that haven't been responded to in over a month, etc.); while the bottom
section sets how the page is organized.

Under Formatting options, you'll see that you can switch the view from List to Table.
Choose Table; this will make Table the default layout of your My unsolved tickets view.
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This opens up another set of options. While there are a lot of choices, it's basically a list of ticket
data which you can select to include in this view. On the right are items of data you will see for each
ticket; and on the left are all the other options you can include. To move items between lists, you just
drag and drop the items you want.

For right now, we just need some really basic data, most of which is already there. We want to see:

1. Who sent in the ticket - called the Requester in the table
2. What the subject line is - called Subject
3. When it came in - Request date

We don't really need score at this moment, so drag and drop it from the right column into the left.
(Score shows you how important a ticket is in relationship to other tickets; helpful, but right now
let's focus on the basics.) Leave everything else the same for now.

So we now have the types of data we want to see about our tickets. What about grouping them by
their status like we set out to do (open or pending)?

You configure this in the Group by section underneath the columns. The drop down should be set
to Status already, but if it's not, open up the drop-down and choose it. You'll see that there are many
options for grouping your tickets in a particular view. This gives you a second level of organization
within your views. For instance, you may want to see all your high priority tickets in one view, but
then group them by which agent they are assigned to; or perhaps, what date they came in. In our
case, we want to see which of our unsolved tickets are open and which are pending.

The next section—Order by—reads Score. We removed score from our columns up above, so
change that to Request date. That will mean that within your groupings—open or pending—they
will be in order of the date they came in, similar to how your email program works probably.

Click the Update view link. Now any time you look at your unsolved tickets view, you'll see them in
the table layout, grouped by their status.
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Removing unused views
Let's continue setting this up so your agents and you can better focus on what's important in your
help desk right now. Even though you want to view your tickets into meaningful chunks or views
(i.e. which tickets are open right now), you don't want more views than necessary. It's like going
through the closet and saying: "Do I really wear this?" If not, get rid of it.

To that end, we'll reduce the number of views you see when you click Views tab in the menu bar
(see picture below).

Zendesk's default views are based on customer service best practices. But when you're just starting
out or if you don't have very many tickets, some of these default views may not be useful yet. We
haven't gone over groups, for instance—so let's disable some of these views.

You can disable views in Zendesk without deleting them. This will allow you add them back to your
list later when you feel they might be helpful. For now, let's disable New tickets in your groups and
Unsolved tickets in your group.

Click on the Manage tab in the top menu bar and choose Views from the sub menu. You'll see that
it lists out the same views you see in the Views top menu drop-down. You also see that there are
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already some inactive views. Roll your mouse over the New Tickets in your groups row. A menu
reveals itself on the right with the option to deactivate. Click Deactivate; the page reloads and now
New tickets in your groups is in the inactive views. Do the same with Unsolved tickets in your
groups.

Looking at our views is a little easier now (see below)

The remaining views in the list address scenarios we have seen and which are useful when you are
just starting out with Zendesk:

1. Looking at all the unsolved tickets
2. Looking at tickets which have been recently updated or recently solved
3. Looking at all the tickets are pending (waiting on information from the customer)

There's one view which contains a piece of Zendesk we haven't addressed yet: unassigned tickets.
All tickets in Zendesk must eventually be assigned to a support agent. Assignment means that
the support agent will receive notifications when the ticket is updated; and it establishes a clear
responsibility. As you are currently the only agent in your Zendesk, all tickets are automatically
assigned to you. We'll look further at ticket assignment in the next lesson when we begin adding
additional agents to your Zendesk.

Summary
In this lesson, we looked at how to organize the tickets we have in our help desk by using Zendesk
views. When you log into your Zendesk, you should open up your views and choose the one that
best fits what you need to do at that moment—typically, either dealing with unsolved tickets; or
checking in with the backlog of tickets that are waiting on more customer information.

We evaluated the difference between list layout and table layout, and chose table layout for our the
My unsolved tickets view. This allowed us to easily distinguish between unsolved tickets that are
open awaiting our action and which were pending on a customer response.

Lastly, because we use views to help us focus on which support requests need our attention, we
turned off certain default views that we don't need yet.
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Extra exercise
Check your My unsolved tickets view and see whether Kelly H. has responded to her ticket. If she
has, it should now be in the Open section of your view. This means she has replied. Because the
ticket is now back in your court, Zendesk automatically moves it from pending to open. Review your
ticket from Kelly H. and solve it. It's not good practice to leave tickets open longer than you have to.

Next Lesson: Working with your whole team
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Working with your whole team
Finally, we will go over how to build up and manage your support team. We will talk about the
various types of users you can have in Zendesk; and how to create accountability within your
support team by assigning tickets to agents. We'll also touch on how to automate some of your work
flow, including automatically assigning tickets to the right support agent based on keyword.

In the previous lesson, we went over how to organize your support tickets into views so your team
and you can focus on which tickets matter most at that moment. In this lesson, we're going to start
setting up your team. We will add an additional support agent to your help desk and show you how
to organize your agents into groups.

Working with others on a support team presents many challenges (as anyone who's tried to share
one group email box will tell you). It can be difficult to know who has responded to what; or which
issues should be handled by which person. The amount of time lost on trying to get your whole
support team on the same page is a productivity killer.

Also, if your team is more than a few people, you probably have agents who specialize in a
particular aspect of your business. When issues related to that aspect come in, you need a way to get
it to that person; and they need a way to manage their personal queue.

To address these challenges, we're going to look at how to assign tickets to people on your support
team. Each ticket within Zendesk is assigned to particular agent—adding a layer of accountability
to your support work. We'll also see how you can use triggers to assign tickets to particular agents
automatically based on the content of the ticket (i.e. all billing issues go to the agent who is the
billing system expert). This will give us a chance to investigate the Zendesk web form, another way
for your customers to get tickets into your Zendesk.

By the end of this lesson, you should be ready to start building up your team and assigning tickets to
them; as well as creating the rules (or triggers) to automate how you assign tickets.

The three types of users in Zendesk
To add an additional agent to your team, go the People page under the Manage menu. Before
we add a new agent, let's quickly look at the People page and the three different kinds of users in
Zendesk.
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The above is a standard set of users for new trial users. The owner of the account is listed at the
bottom (presumably you)—you can see the small owner label underneath their image. The owner is
by default an admin of your Zendesk. You can create additional admins. The role of the admin is to
manage how the help desk works and be in control of many of the global help desk settings.

If you've been following through the previous lessons you'll also see the two people from whom
you received tickets—the customer test account you created in Lesson 1 and Kelly H., the Zendesk
employee whose ticket we discussed in Lesson 4.

These two accounts are called end-user accounts; this is the type of user your customer will be.
End-users can create tickets and contribute to your community forums, but they cannot do or see
any of the behind the scenes management. Note that while you can create new end-user accounts
manually, in most cases they are created automatically simply by the person sending in a ticket. An
end-user does not have to sign up, in other words, to work with your help desk—they can just send
in a ticket and Zendesk will remember them.

Tip! You can change end-user access to your help desk—for instance, require that new users create
an account before they may submit a ticket—in Settings > End-Users tab.

Lastly (though not represented above), are your agents. Agents are those who answer tickets and
moderate forums—they run your support day-to-day. (Note that admins can by default do all the
things that agents can do.) Most support teams are made up of multiple people. Let's grow your team
by adding our first additional support agent.
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Adding and working with more support agents
To add another agent, click Add user in the upper right of the main column. Fill out the form on the
subsequent page, either with one of your colleague's information; or, if you are working alone, or
just want to test Zendesk out further before bringing others in, you may use another of your email
addresses to create a test agent account.

Tip! When setting up Zendesk's we often advise that the owner create a test end-user and a test agent
account. It helps greatly with set up as you can quickly test out how each type of user experiences
the site. When doing so use names like Johnny End-User and Mary Agent, so you can quickly
recognize them in your emails.

To create the new agent:

1. Fill out Name
2. Fill out Email
3. Optionally, upload a Photo
4. Add a note in the Note field that reads "This is <your name>'s test agent account"

You can leave Detailed information, Twitter account, and Organization alone for now.

When you get to roles, select Agent (End-user will be selected by default). A set of options opens
up—these options allow you to finely control this particular person's access and role within your
help desk.

Because we are just getting started, it makes the most sense to bring on another agent with pretty
broad access—someone who can help us get our Zendesk set up. We can always restrict it later. To
do so, leave all the settings as is, except switch Can moderate topics in forums from No to Yes.

Click the Create button and your new agent is created. Notice the Agent label below their image.

Tip! Need to import a lot of users all at once? Zendesk also offers a few ways to bulk import your
users. This user's guide topic explains how.

https://support.zendesk.com/entries/20065732-bulk-importing-users-and-organizations
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The person you signed up will now receive a welcome email with a link that verifies their account
and asks them to choose a password. If you are using one of your own email addresses to test this,
go ahead and check your email and go through the verification process.

Creating accountability within your support team by assigning
tickets

One common problem in support teams with multiple people is establishing who is in charge of
which support requests. If it is everyone's responsibility to answer a particular ticket, then it is
effectively no one's responsibility. In Zendesk, each ticket must eventually have someone assigned
to it (or, as we say it in Zendesk: have an assignee). In the previous lessons all tickets were by
default assigned to you, since you were the only agent in the system.

But now that you have another colleague working with you, the assignee must be set. Why does each
ticket require an assignee? Because it clearly defines responsibility within your support workflow.
Once a ticket is clearly assigned to a particular person, they are much more likely to address it,
simply because no one else will. Assignment can always be passed off to another agent (if, for
instance, another agent has a particular expertise that is better suited to the ticket), but at any given
time it is clearly someone's.

Let's create a new ticket and assign it to the agent we just added to our help desk. Let's assume we
just received a call from one of our customers who is experiencing a billing issue; and that our new
agent is the billing expert in our organization.

While on the phone with the customer, we open up a new ticket within Zendesk by clicking the
New button in the upper right of the menu bar. They are a new customer and have not contacted our
support before, so as in Lesson 4, click the Add a new user  link under the Requester text box.

Click the Create button; this will bring you back to your ticket with the customer details filled in.
Next, we'll fill out the ticket with the customer's issue—say, they were double-charged on their
credit card. The subject can read, 'Double-charge on credit card"; in the description, you can make
a note about what your call was about: "I just got off the phone with this customer who is seeing a
double-charge on their credit card."

Now, we want to assign it to the new agent we just added who is our support person in charge of
billing issues. Notice that there is a new drop-down field on the ticket now: Assignee. Open it up
and choose the new agent you just added. (You'll see that you are also an option in the drop-down as
you are also an agent.) Leave the Status of the ticket to New (until the new agent opens it, it is still a
new issue); change the Type to Incident; and make the priority High. It should look something like
the screenshot below:
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Click the Submit button. A new ticket is created. What happens now?

First, Zendesk automatically notifies any agent who is assigned a ticket. It's fine to assign a ticket
to someone, but it's no use if they don't know it was assigned to them. To confirm that they were
notified, go back into the ticket by either clicking the link in the notification that tells you the ticket
was created or by using the Recent menu in the top menu bar.

Scroll down the Events section of the ticket and click the All events and notifications link on the
right side. We've looked at this in previous lessons—it logs every action taken on a ticket.

Here we see that the ticket was indeed assigned to our newly added agent; and that a notification was
emailed to them (using a trigger).

The email your agent receives looks like this (if you are using your own email to go through this
lesson, you'll receive this email):
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The agent can then either follow the link or respond directly from email to work on this support
request further.

If you look at the Views menu in the upper right, you should now see a difference between My
unsolved tickets and All unsolved tickets. My unsolved tickets collects all the unsolved tickets
assigned to you; All unsolved tickets collects all the unsolved tickets period. Click into All
unsolved tickets—if you remember the previous lesson, you'll see that this view groups the tickets
by assignee (see picture below).

Automatically assigning tickets to agents
Now that we've assigned a ticket to another agent (and gone over the reasons for why each
support request should have an assignee), let's make the process more efficient by automating it.
Remembering Lesson 1, we are going to be building a trigger that automatically assigns billing
related tickets to our new support agent. While there will always be a need for you to manually
assign tickets to other agents, it's a best practice to automate what you can within your help desk.
This will reduce the amount of human error in your support—forgetting to assign the ticket when
you update it say—and also allow your support to scale as more and more requests come in. It's one
thing to read a couple billing related questions and assign them to our billing expert; it's another
thing to do that with hundreds of tickets.
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The process we use here can be used to address most scenarios when you want to automate some
piece of your support.

1. We'll define a task we do often.
2. We'll build a trigger (and any other component in Zendesk we need) to address that task.
3. We'll test what we've built.

We've already defined what we want to automate: the process of assigning billing related support
requests to our new agent (who is the billing expert on our team). Now let's look at the pieces we
need to accomplish that.

Building a web form
First, we need to know which questions are billing questions or not. There are many ways to do this
in Zendesk, but one of the most effective is to configure the support form on your Zendesk support
site.

To see the default support form, we need to put ourselves in our customers shoes. In Zendesk, you
can assume the identity of any user of your support system. This means experiencing your help desk
from their perspective. This can be helpful to guarantee that the system looks and behaves as you
want it to for each person.

Step 1
Click on the Manage menu in the top navigation and choose People. Remember the distinction
between end-user, admins and agents from earlier in the lesson. We want to assume the role of
an end-user. To do so click the Assume link next to one of the end-user accounts (Kelly H., for
instance; or any user without owner or agent underneath their image).
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Step 2
This drops you back on to your home page - it looks similar to the home page we've been looking
at all along, but notice that the navigation bar is different. This is your Zendesk configured for
someone who is looking for support. As such, an end-user can browse whatever knowledge base
article or community forums you've set up, or, as we want to do here, submit a request; you'll see a
button labeled Submit a request in the top menu bar. Click on that button.
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This is the default support form—your customers can come to this page, fill out this form, and just
like sending in an email, it will create a ticket for them in your Zendesk. This ticket will look exactly
the same for your agents and you.

OK, but how are we going to know which support requests that come in through this form are billing
related? The answer is: in it's current form, it'd be pretty tough. Luckily, Zendesk lets you edit and
add things to this form. We are going to add a drop down field for our customers to fill out that asks
them what type of question they are asking. With that information, we'll be able to accurately assign
it to our support agent.

Adding a new field to the support form
To add a new field, we need to return to our admin status. To do so, click the Revert identity link
in the upper right of the page. Anytime you assume the identity of another user in your Zendesk,
you need to click this link to get back your admin perspective. Doing so will drop you on the People
page again.

Now let's add that new field.

Step 1
Click the Manage menu and choose Ticket fields from the options. This page lists all the various
fields on your web form. You may notice that this list has many more fields than the one we were
just looking at as an end-user. In fact, this lists all the fields we saw earlier in the lesson when we
created a new ticket as an admin. What's going on?

Zendesk uses the same ticket form for both your agents and your end-users, it simply shows them
different pieces of that form. The subject field, for instance (the first item on the list) is available to
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both agent and end-user—both types of users can enter in a subject for a ticket. The Status field,
however, can only be seen and changed by an agent.

Your support form is an important tool in capturing support requests because you can add many
different types of information that a simple email simply cannot. While email is often very easy for
customers and very important for the modern support team; the web form can really speed up and
provide your support team with more information upfront.

Step 2
Click the Add custom field  in the upper right of the main column. On the next page select the drop-
down list.

Step 3
Here's where we configure our new field. Give the field a title (this is for internal use, so name it
something you'll understand later like "Support Category") and then add a more descriptive question
in the Field title displayed to end-users. This is what your customers will see when they access
your web form, so it should be something like "What are you writing us about?".

Leave Required for agents unchecked, but definitely check Visible to end-users. This is what will
put it on the customer support form. (Note that if you left that unchecked the field would still appear
on your support form, but only for your agents.)

This opens up a second set of options. Check Editable by end-users—this will make it so that they
can actually open up and choose an option in the drop down (not actually edit its content). You
would leave that box unchecked if you wanted to show them the current value of the field, but not let
them change it, such as if you wanted to show them which agent was assigned to their ticket (which
would be the assignee field, but you didn't want them to be able to change the assignee).

Next, add a short description which will help explain to users what you would like them to do in this
instance, something like "Please specify what type of question or problem you're having."

Lastly, check the Required for end-users box. This makes our drop-down field required for end-
users; they must fill it out before they are allowed to submit their request.

Your drop-down should currently look something like this.
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Step 4
Now we will add the actual options we want our customers to choose from. In the section
labeled Field options add three or four options in the text field labeled Title. Make one of them
"Billing Issue". To add additional fields, click the green plus button to the right of the text fields.

Notice that each time you enter an option, a corresponding tag is created. Zendesk creates these
automatically for you (though you can edit them if you wish). When a customer chooses one of these
options, Zendesk will tag that particular ticket with the corresponding tag. We'll use these tags to
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create our trigger. That tag is how the trigger will know what kind of question it is, specifically if it's
a billing question, and be able to assign it to our billing expert.

Click the Add field button.

Creating a trigger to automatically assign tickets
When you create the custom field, there is a notice at the top of the page that notifies us that we "Use
the field option tags to filter report, view, trigger and automation conditions and actions." We are
going to create a trigger. Click that link.

Triggers, you'll remember, are business rules you define that run immediately after tickets are
created or updated. For example, a trigger can be used to notify the customer when a ticket has
been opened. Another can be created to then notify the customer when the ticket is solved. Zendesk
starts you off with a number of triggers. For a description of those triggers, check out Streamlining
workflow with ticket updates and triggers in the Zendesk User's Guide.

Step 1
We are adding a trigger to automatically assign billing related tickets to our new agent in charge of
billing. Click Add trigger in the upper right.

Triggers contain conditions and actions. You combine these to create "if" and "then" statements (if
the ticket contains a certain set of conditions then the actions make the desired updates to the ticket
and optionally notify the requester or the support staff). You build condition and action statements
using ticket properties, field operators, and the ticket property values.

Step 2
Filling out the form.

Title the trigger "Auto-assign to Billing". Open the drop-down list under the Meet all of the
following conditions header, and choose Tags. This creates a second set of form fields. Leave
the second drop-down list as Contains at least one of the following. In the open text field write
"billing_issue". Remember from the previous section that when a customer chooses "Billing Issue"
on our ticket form it will tag their ticket with "billing_issue". We are leveraging that tag here in this
trigger.

Next, click the green plus button to add another condition. Choose Ticket is... from the drop-
down list. Open the resulting drop down and look at the options: Created and Updated. This is an
important distinction. A ticket can only be created once, but it can be updated any number of times.
In our case, we want this trigger to run when the ticket is created, so choose that in the drop-down
list.

Note:  It's important to understand how triggers work because we only want the trigger to fire once.
If we didn't specify a particular moment, then this trigger would fire every time a ticket tagged
"billing_issue" was updated. Every time you update a ticket (i.e. hit the submit button within the
ticket as seen below), Zendesk runs through your triggers looking to see if that ticket fits any of the
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trigger conditions. We don't want the ticket to be assigned to our billing agent every time the ticket
is updated; we just want it to be assigned once. So we choose created.

That covers the conditions. Next, open the drop-down list under the Perform these actions heading.
What do we want to have happen? We want to assign the billing tickets; so choose Assignee, and
then choose the agent you created earlier in the lesson. It should looks something like this:

Is there anything else we want to do? Well, we probably want to notify our new agent that a ticket
has been assigned to them. We could click the green plus button and add another action. Let's see
what that looks like.

Click the green plus button. Choose Email user from the drop-down list. In the next drop-down list
we want to choose our new agent. We could of course choose their name from the list, but a better
technique is to pick Assignee. Triggers can use placeholders like this—send the email to the person
assigned to this ticket. We just assigned the ticket to our new agent, so that applies in this case.

Now, before we create the default email to send to when a billing ticket comes in, we should come
clean and say we actually don't have to go through the trouble. It turns out that there is an easier and
much more effective way to notify people when a ticket is assigned to them: fire another trigger that
already notifies agents when a ticket is assigned to them.
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We saw before that emails are sent out when a ticket is assigned to an agent (see the picture above).
This was done by one of those default triggers Zendesk starts you off with. It's called Notify
assignee of assignment. It turns out that one Zendesk trigger can trigger another; in our case, we
have one trigger that assigns billing tickets to a particular agent, and we have another trigger that
sends out emails to agents when a ticket is assigned to them. They can work together. To see how,
we need to go back to our list of triggers. Let's save the trigger we're working on and check it out.
Click the red minus button next to our Email user action and then click the Add trigger button at
the bottom.

Step 3. Ordering triggers
As we said, triggers can interact with one another, but they need to be in the correct order to do so.
When a ticket is created or updated, Zendesk runs through all the triggers in order. This means that
we want our Auto-assign trigger to be above the Notify assignee of assignment trigger. This will
ensure that when a customer submits a billing issue ticket, it will first be assigned to our new agent;
and then an email will be sent out to that agent. It doesn't work the other way around: you can't send
an email out to the person assigned to the ticket before the ticket is assigned to anybody.

Our new trigger is down at the bottom. To move it, click the Reorder button at the bottom of the
list. Then drag the Auto-assign bar to the top.

Now, we have all the pieces in place to automatically assign a ticket to someone. Let's test it out.

Testing our trigger
To test the trigger we are going to assume an end-user again. Following the steps from before,
assume an end-user.
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Click Submit a request in the top menu bar. Notice first that our new ticket field is there (sweet!).
Fill out the ticket with a sample billing issue (you can copy what we have below); and make sure
you choose "Billing Issue" from the Reason for writing field.

Click Submit and then Revert identity (click the link in the upper right).

To see the ticket that was just submitted, go to Views > All unsolved tickets. The ticket you created
should be in there. Click into it, and see that it is already assigned to our new agent. And, our new
ticket field is also in there, already set to "Billing Issue".
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Next, let's check further by clicking All events and notifications. Here we can see that not only our
auto-assign trigger worked; but also that one trigger fired the next:

If you used one of your own email addresses for the second agent we added, you will get that
notification in your inbox.

Unassigned tickets
One more small note to wrap up this lesson. Now that you've got more than one agent, you'll
notice that there is an Unassigned tickets view in your View menu at the top. Unless you create an
automatic assignment for all your incoming tickets, they will be unassigned by default. This view is
a good place to check often—you want to make sure that unassigned tickets get assigned quickly.

Conclusion
This was a pretty packed lesson. We went over the three different types of Zendesk users and added
a second agent.

We also introduced the concept of assigning tickets to your agents and went over two methods of
assigning:

1. Manually changing the ticket fields
2. Automatically assigning using a trigger

In order to create the automatic assignment, we created a new ticket field for the Zendesk built-in
support form.

And we checked how this support form worked (and looked) by assuming an end-user.

Now you are ready to add more people to your team as well as build up your support web form and
your work flow!

If you've gone through all the Getting Started Lessons, we have some suggestions about what to do
and where to go next.
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Where to go next

Turning your Zendesk "on"

Email
It is easy to start using your Zendesk for real-life support. If you have a support email address
already in use, simply start forwarding all the incoming mail to your default Zendesk support email
address. Your default support address is support@youraccount.zendesk.com, where "youraccount"
the site name you signed up for Zendesk with.

So, for example, if you currently use support@mondocameras.com for email support, set up that
email address to forward to support@mondocameras.zendesk.com.

For more on using your own email address with Zendesk, refer to Lesson 3: Customizing the
customer experience.

From the moment you start forwarding that mail, all your support communication will start flowing
into Zendesk.

If you don't yet have a support email address you want to use, you can simply publicize your default
Zendesk support email address. Link to this address on your own website. If at any time you want to
start using a custom support email address, all you need to do is set up the forwarding as described
above. With that in place, the transition will be seamless.

On the web
You can also start offering web support through your Zendesk site by linking to your support web
portal home page from your own website. If you don't have one already, add a link to "Support" or
"Help" and make that link go to your Zendesk web portal.

Like your default support email address, your web portal is http://youraccount.zendesk.com.

For more on the web portal read the Configuring the Customer Web Portal Home Page in Lesson 2.

Learn more about Zendesk
Zendesk has a number of resources to which you can turn when you need help or just want to learn
more.

• The Using Zendesk forum has definitive documentation on all the Zendesk features.

https://support.zendesk.com/categories/12128-using-zendesk
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• Zendesk holds regular webinars—live demonstrations and Q&As about how to use Zendesk
and many of its features.

• The Zendesk Support Forums are an active area of discussion about best practices and new
features.

Below are some specific resources that might be of interest to you after this guide:

Streamlining your workflow
• Managing the Help Desk Workflow (Using Zendesk)
• Beginning Zendesk (webinar)

Gaining business insight with support reporting & analytics
• GoodData for Zendesk (webinar)
• Intermediate Zendesk (webinar)

Building and extending your help desk
• Customizing and extending your help desk  (Using Zendesk)
• Zendesk Integrations Overview

Getting help
Of course, Zendesk support agents are on hand to answer questions and offer advice should you need
it. Depending on your plan, you can reach us through:

• Our support web site: http://support.zendesk.com(Starter, Regular, Plus+)
• Email: support@zendesk.com (Regular, Plus+)
• Phone (Plus+)

• +1 (415) 418 7506
• +44 20 3355 7960
• +61 3 9008 6775

• Skype: zendesk

Note that while you are in your trial period, you have all the features and support of the Plus+ plan.

And we make announcements and listen to feedback on our social channels as well:

• Twitter: http://www.twitter.com/zendesk
• Facebook: http://www.facebook.com/zendesk

http://zendesk.com/webinars
http://support.zendesk.com
https://support.zendesk.com/forums/20004401-managing-the-help-desk-workflow
http://www.zendesk.com/blog/zendesk-101
http://www.zendesk.com/blog/gooddata-for-zendesk-twice-the-help-desk-data
http://www.zendesk.com/blog/webinar-creating-ticket-fields-tags-custom-reports-and-more
https://support.zendesk.com/forums/20004416-customizing-and-extending-your-help-desk
http://www.zendesk.com/integrations
http://support.zendesk.com
http://www.twitter.com/zendesk
http://www.facebook.com/zendesk
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